RE NESAS Application Note

Bluetooth Low Energy Smartphone Application Example
TryBT for iOS

Overview

TryBT is an iOS sample application that can communicate with the evaluation boards for RX23W, RA4W1, or
REO01B which are Renesas Electronics' MCU by Bluetooth® Low Energy wireless technology. This app is
distributed as a sample project including source code, so users can customize and reuse the source code.

This document will explain how to create a development environment as well as how to perform basic
customization of TryBT.

Target Devices
e {OS device (i0S 13.0 or later)

Related Documents

e  RX23W Group Target Board for RX23W Quick Start Guide (R20QS0014)

e RX23W Group Target Board for RX23W module Quick Start Guide (R20QS0022)

e  RA4W1 Group Evaluation Kit for RAAW1 EK-RA4W1 Quick Start Guide (R20QS0015)

e REO01B Group Bluetooth Low Energy Sample code (using CMSIS Driver Package) (RO1AN5606)

e Renesas Flash Programmer V3.08 Flash memory programming software User's Manual (R20UT4813)

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of
such marks by Renesas Electronics Corporation is under license. Other trademarks and registered
trademarks are the property of their respective owners.
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1. Overview

TryBT works on iOS devices running iOS 13.0 or later. This app connects to the Target Board for RX23W
and displays a sample screen to perform demonstration. Also, source code of this app is distributed as an
iOS project that can be modified.

1.1 Operational Environment
e {OS device (i0S 13.0 or later)

e  Macintosh PC

e Any of the evaluation boards below:
- Target Board for RX23W or Target Board for RX23W module NOTE
- EK-RA4W] NOTE2
-  EB-REQ1B NOTE3

NOTE1 A firmware that can communicate with TryBT is written to Target Board for RX23W at the factory. If
you write a firmware for communicating with TryBT to the board again, write the prebuilt firmware
included in the quick start guide below to the Target Board for RX23W.

RX23W Group Target Board for RX23W Quick Start Guide (R20QS0014)
—>ble_demo_tbrx23w_profile_server_preinstall_yyyymmdd.mot file in mot folder
RX23W Group Target Board for RX23W module Quick Start Guide (R20QS0022)
—>ble_demo_mtbrx23w_profile_server_preinstall_yyyymmdd.mot file in mot folder

NOTE2 A firmware that can communicate with TryBT is written to EK-RA4W1 at the factory. If you write a
firmware for communicating with TryBT to the board again, write the prebuilt firmware included in
the quick start guide below to the EK-RA4W1.

RA4W1 Group Evaluation Kit for RA4W1 EK-RA4W1 Quick Start Guide (R20QS0015)
—>Restore_Factory/r20gs0015.srec included in bin.zip

NOTE3 A firmware that can communicate with TryBT is written to EB-REO01B at the factory. If you write a
firmware for communicating with TryBT to the board again, write the firmware included in the
document below to the EB-REO1B.

REO01B Group Bluetooth Low Energy Sample code (using CMSIS Driver Package) (RO1AN5606)
—>ble_project_server.hex in ROM_Files folder

Hereinafter, this document will describe operations using Target Board for RX23W. These operations are
same as when either EK-RA4W1 or EB-REO1B is used.
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https://www.renesas.com/search?keywords=R20QS0022&f%5B0%5D=file_type%3ASample%20Code
https://www.renesas.com/search?keywords=R20QS0015
https://www.renesas.com/search?keywords=R01AN5606&f%5B0%5D=file_type%3ASample%20Code
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Hardware required for checking TryBT operation:
e iOS device: iOS 13.0 or later

e  Macintosh PC

e Target Board for RX23W

iOS device tested:
e iPhone SE 2" Generation (iOS 14.7)

Software required for checking TryBT operation:
e MacOS 10.14.4 Mojave or later
e  Xcode 11.0 or rater (refer to Section 2.1 for more information)

TryBT Project:

¢ Implementation Language: Swift ((https://www.apple.com/jp/swift/))

Before Using:

To install and check the operation of the TryBT project on iOS device, you need to become a paid member of
the Apple Developer Program.

https://developer.apple.com/programs/
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1.2 NOTES

e This document was created based on the status on 30" Sept 2021. It is not guaranteed that information
described in this document supports all of the future versions of software and tools provided by our
company or third parties.

e Renesas Electronics disclaims any and all liability arising from the use of information in this document
and related software. Please also refer to the "Notice" in the last page of this document.
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2. Environment Configuration

2.1 Installing Xcode
Install Xcode, Integrated Development Environment.

1. Open App Store and type "Xcode" in the app search field.
2. Select “Install’.

2.2 Installing Homebrew

Homebrew is a package manager for installing and managing various libraries within the Mac OS
environment. Install it to build your development environment.

1. Open the following URL: https://brew.sh/
2. Select the icon next to the shell script command shown on the screen to copy the command.

Homebrew

The Missing Package Manager for macOS (or Linux)

Search Homebrew

English ~

Install Homebrew

Paste that in a macOS Terminal or Linux shell prompt.  The seript explains what it will do and then pauses
before it does it. Read about other

Figure 2.1 Installing Homebrew (1)
3. Open Finder, go to [Applications]->[Utilities], and run Terminal.
i Utilities

- @ w B 8 &

Applications
Activity Monitor AirPort Utility Audio MIDI Setup Bluetooth File Boot Camp ColorSync Utility
Desktop Exchange Assistant

Documents o o >
WARNIN
Downloads AY 7:36 N/ o a m %
3 \ ( 4

Console Digital Color Grapher Keychain Access Migration
5 iCloud Drive Meter Assistant

) B ) B
. iPhone Lm., " LAY,

Network
Screenshot Script Editor Terminal VoiceOver Utility
Information

Figure 2.2 Installing Homebrew (2)
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4. Paste the command copied in step 2. into the Terminal and then execute it.

[$/bin/bash -c "$(curl -fsSL https://raw.githubusercontent.com/Homebrew/install/HEAD/install.sh)"
Checking for ‘sudo’ access (which may request your password).

[Password:
This script will install:

/opt/homebrew/bin/brew

/opt/homebrew/share/doc/homebrew

/opt/homebrew/share/man/manl/brew.1
/opt/homebrew/share/zsh/site-functions/_brew
/opt/homebrew/etc/bash_completion.d/brew
/opt/homebrew

Press RETURN to continue or any other key to abort

Figure 2.3 Installing Homebrew (3)

5. Type "brew" in the Terminal and confirm the tips are displayed.

o0

[$brew

Example usage:
brew search TEXT|/REGEX/
brew info [FORMULA|CASK...]
brew install FORMULA|CASK...
brew update
brew upgrade [FORMULA|CASK...]
brew uninstall FORMULA|CASK...
brew list [FORMULA|CASK...]

Troubleshooting:
brew config
brew doctor
brew install --verbose --debug FORMULA|CASK

Contributing:
brew create URL [--no-fetch]
brew edit [FORMULA|CASK...]

Further help:
brew commands
brew help [COMMAND]
man brew
https://docs.brew.sh

Figure 2.4 Installing Homebrew (4)
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2.3

Installing latest version of Ruby

Use Homebrew to update Ruby to the latest version, then install CocoaPods to manage Xcode's libraries.

1.

2
3.
4

Open Finder, go to Applications-> Utilities, and run Terminal

. Execute the following command : brew install ruby-build

Execute the following command : brew install rbenv

. To add Ruby configuration to the PATH, execute the following commands:

cd

echo 'export PATH="$HOME/.rbenv/shims:$PATH"' >> .bash _profile
echo 'eval "$(rbenv init -)"' >> .bash_profile
source .bash_profile

LN 5]
$cd
$echo 'export PATH="$HOME/.rbenv/shims:$PATH"' >> .bash_profile

$echo 'eval "$(rbenv init -)"' >> .bash_profile
$source .bash_profile

sl

Figure 2.5 Setting for Ruby

NOTE: /bin/bash is used in the above as a shell. For how to change default shell, refer to the URL below:

https://support.apple.com/quide/terminal/trml113/mac

5. Run ruby -v to make sure your ruby version is 2.2.2 or later. If you are running former version, install the

latest one with the following commands and reboot the terminal.

rbenv install -1, to display a list of installable versions
rbenv install x.Xx.Xx, to install the specified version
rbenv global x.x.x, to switch to the specified version
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2.4 Installing CocoaPods

CocoaPods is a tool to manage third-party libraries for iOS apps. TryBT project uses CocoaPods to manage
its libraries. Access the URL below and to install it:

https://quides.cocoapods.org/using/getting-started.html

2.5 Opening a TryBT Project
Open a TryBT project in Xcode.

1. Unzip the TryBT zip file attached to this document.
2. Move the unzipped folder to any folder.
3. Start Terminal and go to the above folder with cd command.
4. Execute the following command: pod install
The library used by the TryBT project will be installed automatically:

If the error below occurs by the pod install command, select [Xcode]>[Preferences...] in Xcode
menu and configure Command Line Tools in Location tab.
xcode-select: error: tool 'xcodebuild' requires Xcode, but active developer directory
'/Library/Developer/CommandLineTools' is a command Line tools instance

Locations

“ =)

Text Editing Ke s Sc ntrol Co s Locations Se

Locations Custom Paths

Derived Data: | Default

Advanced...

Archives: | Default

Command Line Tools: | Xcode 12.5.1 (12E507)
]

Figure 2.6 Configuring Command Line Tools

5. TryBT.xcworkspace will be created in the same folder. Double-click TryBT.xcworkspace to open the
TryBT project.

vard  TryBT

Name

AirDrop Podfile

Recents B Podfile.lock
> @ Pods
> | TryBT
Desktop B TrvRT ¥endenroi
Documents B TryBT.xcworkspace
>m IryBl lests
> @ TryBTUITests

Applications

Downloads

Figure 2.7 Opening TryBT Project
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2.6 Setting up an Apple Developer account
To install TryBT on your device, you will need to set up a subscribed Apple Developer account in XCode.

1. Select [Xcode]=>[Preferences] in Xcode menu.
2. Click the [+] button at the bottom left of Accounts tab and add your Apple Developer account.

Accounts

@ AppleiD

Apple ID:

Description:

Download Manual Profiles Manage Certificates...

Figure 2.8 Setting-up an Apple Developer Account (1)

Select the type of account you would like to add:

Apple ID

@8] Xcode Server

gl Bitbucket Cloud

®8)| Bitbucket Server

Cancel Continue

Figure 2.9 Setting-up an Apple Developer Account (2)
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Sign in with your Apple ID.

Don't have an Apple ID? You can create one for free.

Apple ID

Cancel

Figure 2.10 Setting-up an Apple Developer Account (3)

RO1AN6102EJO100 Rev.1.00 Page 12 of 54
15. Oct, 2021 RENESAS



Bluetooth Low Energy Smartphone Application Example

TryBT for iOS

2.7 Creating a Certificate Signing Request
Create the Certificate Signing Request file required for installing to iOS device.

1. Launch Finder, go to [Applications]->[Utilities], and open Keychain Access.

AirDrop
Recents
Applications
Desktop
Documents

Downloads

iCloud Drive

[l iPhone

© Network

Utilities

Activity Monitor

WARNIN
AY 7:36

Console

(=)

LEJ

Screenshot

AirPort Utility

Digital Color
Meter

v

Script Editor

illd

Audio MIDI Setup

Disk Utility

Information

I

Bluetooth File Boot Camp
Exchange Assistant

8 -

Grapher Keychain Access

-] B

Terminal VoiceOver Utility

Figure 2.11 Creating a Certificate Signing Request (1)

ColorSync Utility
Migration
Assistant

2. Select [Keychain Access]—>[Certificate Assistant]>[Request a Certificate From a Certificate Authority] in
Keychain Access menu.

3. Enter your Apple Developer Program email address in the User Email Address field and enter your name
in the Common Name field. Select "Save to disk". Click Continue button to save the Certificate Signing

Request.

Certificate Assistant

Certificate Information

User Email Address:

Common Name:

CA Email Address:

Request is:

Emailed to the CA

® Saved to disk

Let me specify key pair information

Enter information for the certificate you are requesting. Click
Continue to request a certificate from the CA.

Continue

Figure 2.12 Creating a Certificate Signing Request (2)

RO1AN6102EJ0100
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2.8 Creating and Installing Developer Certificate
Create and install a Developer's Certificate, which is required to install TryBT on your device.

1. Sign-in to the Apple Developer and select "Certificates, IDs & Profiles" from the left side menu.

Apple Developer
https://developer.apple.com/

& developer.apple.com

& Developer Account v

Renesas Electronics Corporation

= Overview

©® Membership

@ People
@ Certificates, IDs & & 3 A
Profiles [
People Certificates, Identifiers & App Store Connect
4 App Store Connect R A Profiles

@ CloudKit Console

X Code-Level Support

E Documentation

© Downloads

O Forums

(J Feedback Assistant

Figure 2.13 Creating Developer Certificate (1)

2. Select [Certificates] from the left menu and click blue [+] button next to Certificate.

& developer.apple.com

& Developer
Certificates, Identifiers & Profiles
Certificates Certificate Q All Types
Identifiers
NAME TYPE PLATFORM CREATED BY EXPIRATION
Devices
Profiles
Keys
More
Copyright © 2021 Apple Inc. Al rights reserved. Terms of Use  Privacy Policy
e ——————————————

Figure 2.14 Creating Developer Certificate (2)
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3. Select "Apple Development" and click Continue button.

& developer.apple.com

& Developer

Certificates, Identifiers & Profiles

< All Certificates

Create a New Certificate

Software

o

Apple Development
Sign development versions of your iOS, macO$, tvOS, and watchOS apps. For use in Xcode 11 or later.

Apple Distribution
Sign your apps for submission to the App Store or for Ad Hoc distribution. For use with Xcode 11 or later.

iOS App Development
Sign development versions of your iOS app.

iOS Distribution (App Store and Ad Hoc)
Sign your i0S app for submission to the App Store or for Ad Hoc distribution

Mac Development
Sign development versions of your Mac app.

Mac App Distribution

This certificate is used to code sign your app and configure a Di profile for
to the Mac App Store.

Mac Installer Distribution
This certificate is used to sign your app's Installer Package for submission to the Mac App Store

e ——

Figure 2.15 Creating Developer Certificate (3)

4. Select the Certificate Signing Request that you have already created on Choose File and then click
Continue button.

& developer.apple.com

& Developer

Certificates, Identifiers & Profiles

< All Certificates
Create a New Certificate
Upload a Certificate Signing Request

To manually generate a Certificate, you need a Certificate Signing Request (CSR) file from your Mac.
Learn more >

Choose File C

Copyright © 2021 Apple Inc. All rights reserved,

Figure 2.16 Creating Developer Certificate (4)

Back

|
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5. The Certificate has now been created. Click Download button to download Certificate. Double-click the
downloaded Certificate to install it.

& developer.apple.com

& Developer

Certificates, Identifiers & Profiles

< All Certificates

Download Your Certificate

Certificate Details

Certificate Name Certificate Type
Development

Expiration Date Created By
2022/10/05

Figure 2.17 Creating Developer Certificate (5)
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2.9 Creating App ID for TryBT
Create an App ID of TryBT. App ID is unique across whole iOS applications.

1. Select [Identifiers] from the left menu and click the blue [+] button next to Identifiers.

& developer.apple.com

& Developer

Certificates, Identifiers & Profiles

Certificates Identifier Q AppIDs
NAME IDENTIFIER

Devices
Profiles
Keys

More

Figure 2.18 Creating App ID for TryBT (1)

2. Select "App IDs" and click Continue button.

& developer.apple.com

& Developer

Certificates, Identifiers & Profiles

< All Identifiers

Register a new
identifier

© ApplDs

Register an App ID to enable your app, app extensions, or App Clip to access available services and identify
your app in a provisioning profile. You can enable app services when you create an App ID or modify these
settings later.

Services IDs
For each website that uses Sign in with Apple, register a services identifier (Services ID), configure your
domain and return URL, and create an associated private Key.

Pass Type IDs

Register a pass type identifier (Pass Type ID) for each kind of pass you create (i.e. gift cards). Registering
your Pass Type IDs lets you generate Apple-issued certificates which are used to digitally sign and send
updates to your passes, and allow your passes to be recognized by Wallet

Website Push IDs

Register a Website Push Identifier (Website Push ID). Registering your Website Push IDs lets you generate
Apple-issued certificates which are used to digitally sign and send push notifications from your website to
mac0s.

iCloud Containers
Registering your iCloud Container lets you use the iCloud Storage APIs to enable your apps to store data and
documents in iCloud, keeping your apps up to date automatically.

App Groups

e ———————————————————————

Figure 2.19 Creating App ID for TryBT (2)
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3. Select "App" and click Continue button.

& developer.apple.com

& Developer

< All Identifiers

Register a new
identifier

7\
@
-

App Clip

Certificates, Identifiers & Profiles

g
8
2

Figure 2.20 Creating App ID for TryBT (3)

4. Create an App ID. Type “TryBT Development" in the Description field. Leave App ID Prefix as it is. Type
a reverse lookup of the company's domain followed by ".TryBT" in the Bundle ID field.

& developer.apple.com

& Developer

< All Identifiers

Register an App ID

Platform
i0S, macOs, tvOS, watchOS

Certificates, Identifiers & Profiles

App ID Prefix
RM4ZZ9ZAD4 (Team ID)

I TryBT Development]

You cannot use special characters such as @, &, *,

Capabilities App Services

ENABLED NAME

@ Access WiFi Information

App Attest

B8 App Groups

Apple Pay Payment Processing

Figure 2.21 Creating App ID for TryBT (4)

i Widea:

JI com.renesas.TryBT
We rec nend using a reverse nam le string (
om. nar a ontain an asteris

RO1AN6102EJ0100 Rev.1.00
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5. Scroll down the screen and check Push Natifications, then click Continue button. Then, click Register
button.

Y M < [ )] & developer.apple.com ] © O + ©

< All Identifiers

Register an App ID
Personal VPN

D Push Notifications

® Sign In with Apple

SiriKit

@ System Extension

[ . o s
Time Sensitive Notifications

Cg@ User Management

% Wallet

=) Wireless Accessory Configuration

[l Mac Catalyst

Copyright ® 2021 Apple Inc. All rights reserved.  Terms of Use  Privacy Policy

e

Figure 2.22 Creating App ID for TryBT (5)
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2.10 Confirming UDID of iOS Device
Confirm the UDID of iOS device that you will install TryBT.

1. Connect the iOS device to the Mac via a wired connection.

2. Launch Xcode and select [Window]->[Devices and Simulators].

3. Select iOS device in Devices. The value displayed in Identifier field will be the UDID of the iOS device.

iPhone
Devices  Simulators 10S 14.6 (18F72)

LY ne SE
c 3.11 GB (50.68 GB available) Take Screenshot
S View Device Logs

0 iPhone Identifiel. 00008030-00! Open Console

watchOS Identifier

Identifier

com.renesas.TryBT

+ (@ Filter

Figure 2.23 Confirming UDID of iOS Device

RO1AN6102EJO100 Rev.1.00
15. Oct, 2021 RENESAS

Page 20 of 54



Bluetooth Low Energy Smartphone Application Example TryBT for iOS

2.11 Registering iOS device
Register the UDID on the Apple Developer.

1. Select Devices form the left menu and click the blue [+] button next to Devices.

& developer.apple.com

& Developer

Certificates, Identifiers & Profiles

Certificates DeVIce Q AllTypes~ [ edi J
Identifiers
- NAME IDENTIFIER TYPE
Profiles
Keys

More

Figure 2.24 Registering iOS Device (1)

2. Select "iOS, tvOS, watchOS" from Platform field. Enter a name to identify iOS choice in Device Name
field and the UDID of iOS device in Device ID (UDID) field. Click Continue button and then click Register
button in the next page.

& developer.apple.com

& Developer
Certificates, Identifiers & Profiles

< All Devices

Register a New Device

Register Devices
To crea

Register a Device Register Multiple Devices

Name your device and enter its Unique Device Identifier (UDID). Upload a file containing the devices you wish to register. Please note that a maximum of
100 devices can be included in your file and it may take a few minutes to process.
Download sample files >

I [i0s, wos, watchos % II Device List

. Choose File

Device ID (UDID)

T ——————————

Figure 2.25 Registering iOS Device (2)
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2.12 Creating a TryBT Profile

Create a Profile. The Profile is a file that centrally manages the App ID of the application, the device, etc.

1. Select Profiles from the left menu and click the blue [+] button next to Profiles.

& developer.apple.com

& Developer

Certificates, Identifiers & Profiles

Profile

NAME PLATFORM TYPE

Certificates
Identifiers
Devices
Keys

More

Copyright © 2021 Apple Inc. Al rights reserved. ~ Terms of Use  Privacy Policy

Q All Types

All Platforms

EXPIRATION

‘ Edit J

e ————

Figure 2.26 Creating a TryBT Profile (1)

2. Select "iOS App Development" and click Continue button.

& developer.apple.com

& Developer
Certificates, Identifiers & Profiles

< All Profiles

Register a New Provisioning Profile

Development

©  i0S App Development

Createa profile to install

apps on test devices.

tvOS App Development

Create a ing profile to install apps on tvOS test devices.

macOS App Development

Create a profile to install apps on test devices.
Distribution

Ad Hoc

Create a distribution provisioning profile to install your app on a limited number of registered devices.

tvOS Ad Hoc

Create a distribution provisioning profile to install your app on a limited number of registered tvOS devices.

App Store

Create a distribution provisioning profile to submit your app to the App Store

tvOS App Store

Create a distribution provisioning profile to submit your tvOS 2 the App Store.

Figure 2.27 Creating a TryBT Profile (2)
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3. Select the App ID for TryBT and click Continue button.

& developer.apple.com

& Developer

Certificates, Identifiers & Profiles

< All Profiles

Generate a Provisioning Profile Back |||

Select Type > Configure > Generate > Download

Select an App ID

If you plan to use services such as Game Center, In-App Purchase, and Push Notifications, or want a Bundle ID unique to a single app, use an explicit App ID. If you want to create one
provisioning profile for multiple apps or don't need a specific Bundle ID, select a wildcard App ID. Wildcard App IDs use an asterisk (*) as the last digit in the Bundle ID field.

App ID: 12 Apo IDs
I TryBT Development (: com.renesas TryBT) I

Copyright © 2021 Apple Inc. All rights

Figure 2.28 Creating a TryBT Profile (3)

4. Specify the Certificate that you created.

& developer.apple.com

& Developer
Certificates, Identifiers & Profiles

< All Profiles

Generate a Provisioning Profile gack | |

Select Type > Configure > Generate > Download

Select Certif
Select the ce

10f 6 item(s) selected

Copyright © 2021 Apple Inc. Al rights reserved. ~ Terms of Use  Privacy Polic:

e ————

Figure 2.29 Creating a TryBT Profile (4)
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5. Select iOS devices and click Continue.

@ developer.apple.com

Certificates, Identifiers & Profiles

< All Profiles

Generate a Provisioning Profile

Select Type > Configure > Generate > Downlo

Select Devices

Select th this ¢

© Include Mac Devices

Select All

Copyright © 2021 Apple Inc. Al rights reserved.  Terms of Use  Privacy Policy

Back

=

5 of 48 item(s) selected

S —————

Figure 2.30 Creating a TryBT Profile (5)

6. Enter a name to identify the profile. In this example, "TryBT Profile" is entered. After entering, click

Generate button.

& developer.apple.com

[ Developer
Certificates, Identifiers & Profiles

< All Profiles

Generate a Provisioning Profile

Select Type > Configure > Generate > Download

Review, Name and Generate.

The name you provide will be used to identify the profile in the portal.

I TryBT Profile] ]I

Type
Development

App ID
TryBT Development( com.renesas.TryBT)

Certificates
1Selected

Devices
5 Selected

Copyright @ 2021 Apple Inc. Al rights reserved. | Terms of Use | Privacy Policy

Back

Generate

T ——————————

Figure 2.31 Creating a TryBT Profile (6)
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7. Click Download button to download the Profile.

& developer.apple.com

& Developer
Certificates, Identifiers & Profiles

< All Profiles

Generate a Provisioning Profile |

Download and Install

Download and double click the following file to install your Provisioning Profile

Name: TryBT Profile
Type: Development
App 1D .com.renesas.TryBT

Expires: 2022/10/05

Figure 2.32 Creating a TryBT Profile (7)
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2.13 Associating Profile with TryBT Project
Associate the download Profile with the TryBT project.

1. Select TryBT Project in Xcode.

2. Select TryBT under [TARGETS] and then select "Signing & Capabilities" tab.
3. Remove the check from "Automatically manage signing".
4. Enter the App ID you entered to Apple Developer in the Bundle Identifier field.
5. Click the Provisioning Profile. Select "Import Profile" and specify the Profile downloaded by Section 2.12.
® [El] > & TryBT)  iPhone Finished running TryBT on iPhone
HZaMsAegsED @ o« [# TryBT.xcodeproj
s ® TryBT m | B ™eET
> ® Pods (N General Signing & Capabiliti Resource Tags Info Build Settings Build Phases Build Rules
PROJECT Cap. All| Debug Release
B Tyt v Signing
JARGELS Automatically manage signing
= TryBT
M TryBTTests
Team Renesas Electronics Corporation
M TryBTUITests
Bundle Identifier com.renesas.TryBT
Provisioning Profile | TryBT Profile
Signing Certificate Apple Development:
Figure 2.33 Associating Profile with TryBT Project
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2.14 Compiling and Installing TryBT
Connect iOS device to Mac via wire and install TryBT.

1. Open the TryBT project.
2. Connect the iOS device to Mac.

3. When the device connects correctly, the device name will be displayed at the top of Xcode.

- TryBT ) iPhone Finished running TryBT on iPhone

@ TryBT.xcodeproj

>[4 TryBT
> [# Pods General Signing & Capabilities Resource Tags Info Build Settings Build Phases Build Rules

PROJECT v Identity

B TrysT
TARGETS Display Name

,!| TryBT Bundle Identifier com.renesas.TryBT

M TryBTTests Version 1.0

Figure 2.34 Connecting iOS Device (1)

NOTE: If the display at the top of Xcode is not changed after iOS device is connected, click the top of Xcode
and select an iOS device from the dropdown list of [IOS Device].

# My Mac (Designed for iPhone)
v iPhone

;"’ Any iOS Device (arm64)

4, iPad (8th generation)

&, iPad Air (4th generation)
Figure 2.35 Connecting iOS Device (2)

4. Click the play button in the upper left corner of the Xcode to start compiling and installing TryBT.

[ ] E > = TryBT ) iPhone Finished running TryBT on iPhone
MR AaAACsFDBE B8 [® TryBT.xcodeproj
#) TryBT
> @ TryBT W B
> B Pods General Signing & Capabilities Resource Tags Info Build Settings Build Phases Build Rules

PROJECT v Identity

B TryBT
TARGETS Display Name

> |dentifi I N
’!| TryBT Bundle Identifier com.renesas.TryBT

Ml TryBTTests Version 1.0

Figure 2.36 Compiling and Installing TryBT
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3. Writing Firmware to Evaluation board

Here is an example of using the Target Board for RX23W as the evaluation board. As for the other boards,
refer to documents introduced by section 1.1.

A firmware that can communicate with TryBT is written to Target Board for RX23W at the factory. This
chapter describes how to write a firmware to Target Board for RX23W again.

1. Access the URL below. After logging in by My Renesas account and agreeing to the disclaimer, you can
download a zip file.
https://www.renesas.com/document/scd/rx23w-group-target-board-rx23w-quick-start-quide-sample-code

2. Unzip the zip file downloaded by the step 1. Pre-built firmware is the mot file below.
Jmot/ble_demo_tbrx23w_profile_server_preinstall_20191009.mot

On the following pages, Steps to write a pre-built firmware to Target Board for RX23W. To write the
firmware, the tool below can be used.
Renesas Flash Programmer (Programming GUI)

https://www.renesas.com/software-tool/renesas-flash-programmer-programming-qui
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Bluetooth Low Energy Smartphone Application Example TryBT for iOS

3. When you write a firmware, change the ESW 1-2 to ON and connect the ECN1 connector to PC via
USB cable.

EC4
]

ECB
ER S O ERSEC2ECN2,
N 7

............

[RI001-P01398
FOCIDZAENDXRK23NTBQS6
C:20194-RX23WTBQS6

cR2(+3] W] ©
[ ‘ R32
u—:oo;;;

:‘.' o~ ';.
-, L o o
Figure 3.1  Target Board for RX23W Setting for Writing Firmware

4. Start the Renesas Flash Programmer and select "File">"New Project".

& Renesas Flash Programmer V3.08.01 (Free-of-charge Edition) — *

File | Hel
‘' Mew Project...

Open Project...

Save Project

Save |mage File...

Figure 3.2  Writing Firmware to Target Board for RX23w (1)

5. Inthe Create New Project dialog, set the following settings and click Connect button.
Microcontroller: RX200
Project Name: any name
Project Folder: any place

Tool: E2 emulator Lite

Interface: FINE

Power: None
Es Create New Project — X

Project Information

Microcantraller 200

Praject thrx 23w

N

Praject Fal C¥ble¥workzpace Browse...

Communication

ﬁo: E2 emulator Lite ~ Interface: |FIMNE >

Tool Details.. Mum: AutoSelect Power: Mone

L oonnest 2 | Cancel
Figure 3.3  Writing Firmware to Target Board for RX23w (2)
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6. Configuration steps complete when "Operation completed" is displayed.
7. Specify the following firmware included in the folder of step2 and click Start button.

Program File:

mot/ble_demo_tbrx23w_profile_server_preinstall_20191009.mot

£ Renesas Flash Programmer V3.08.01 (Free-of-charge Edition) —

Eile  Device Information  Help

n : Operation Settines  Block Settings  Flash Options  Connect Settings  Unique Code

Project nformation
Gurrent Project: th rx2 3w rp)
Microcontrallet: RA200 Series Endiar: | Littl=

Program File

GRC-32: 10C1F 345

Flash Operation
Eraze > Program > Werify

o>

Figure 3.4  Writing Firmware to Target Board for RX23w (3)

8. "Operation completed" will be displayed after writing a firmware.
9. Detach Target Board for RX23W from PC.

10. When you run the firmware, change the ESW 1-2 to OFF and connect the CN5 connector to PC via
USB cable.

Figure 3.5 Target Board for RX23W Setting for Running Firmware

*

C¥ble¥motéble_demo_thrx 23w profile_server_preinstall_20191009 mot ‘ Browege... ’
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4. Basic Operation of TryBT

Here is an example of using the Target Board for RX23W as the evaluation board.

4.1 Device List Screen

When the app is launched, Device List screen is displayed. This screen shows a list of connectable devices

and its connection status.

Target Board for RX23W is displayed as "RBLE-DEV" in Device List Screen. Tapping "RBLE-DEV" will
establish a connection to Target Board for RX23W and display Connected Device Detail Screen.

No SIM &

Filte NO FILTER

= -52 (noname)

=71 (no name)

=79 (no name)

)
&
4

(no name)

%)

(no name)

Sort

? -40 RBLE-DEV

76 (no name)

73 (no name)

see II

O &

NO SORT

Figure 4.1 Device List Screen (1)

Filtering devices can be performed by selecting Filter type.

No SIM = -

.

O £ :

.

Filf NOFILTER Jsort NO SORT

= 52 (noname) >
-71 (ne name) >

=78 (no name) >

% 58 (noname] >
o 62 (noname) >
% -40 RBLE-DEV >
-76 (no name) >

73 (no name) >

No SIM & (-
O & :
Ll
Filte NO FILTER | Sort = NO SORT
% 52 (noname) DISCONNECTED
Select filter type >
No filter ED >
RSSI > -30dbm
> ED >
RSSI > -67dbm
4 RSSI > -70dbm o>
RSSI > -80dbm
* . o 1D D>
76 (no name) DISCONNECTED »
73 (no name) DISCONNECTED >

Figure 4.2 Device List Screen (2)
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Order of the device list can be specified by selecting Sort order.

No SIM 7

Filte

.’)

9)

4)

)

NO FILTER

-52

-79

58

-62

-40

-76

(no name)

(no name)

(no name)

(no name)

(no name)

RBLE-DEV

(no name)

{no name)

O

%

Sort § NO SORT

No SIM &

O @

Filte NO FILTER ' Sort = NO SORT

= -

52 (no name) DISCONNECTED »
71 (no name) DISCONNECTED >
Select sort order ED >

No sort

Sort by RSSI(Descending)

ED >

ED >

-40

RBLE-DEV. DISCONNECTED »

(no name) DISCONNECTED »

(no name) DISCONNECTED >

Figure 4.3 Device List Screen (3)

Device list is reloaded by tapping Reload button.

No SIM =

Filte RSSI>-70
% 43 RBLEDEV
= -45 (noname)
? 49 (ne name)
% 50 (noname)
% 58 (noname)
= 60 (noname)
= 61 (noname)
& 67 (noname)

Sort

@)

%

RSSI(DESC)

Figure 4.4 Device List Screen (4)
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Tapping setting button will display "Register UUID name" and "Bluetooth Settings".
Service Name of GATT Profile and its UUID can be registered by selecting "Register UUID name". Service

name registered is displayed in Detailed Information of Connected Device Detail Screen. Note that only one
UUID can be registered in this setting. For display example, see

To display Service Name implemented in Target Board for RX23W, register any of the following
combinations of UUID and Service Name.

00001800-0000-1000-8000-00805f9b34fb: GAP Service
00001801-0000-1000-8000-00805f9b34fb: GATT Service

58831926-5f05-4267-ab01-b4968e8efce0: LED Switch Service

No SIM &

Filte NO FILTER

T =
-7

L —4

T 8

L —3 -

- 62

&

{no name)

(no name)

(no name)

{no name)

RBLE-DEV

Sort

O

30

NO SORT

No SIM 5

Filte NO FILTER

-93

-85

-73

-75

(no name)

RBLE-DEV

(no name

(no name,

(no name)

Sort

Setting

O & :

NO SORT
DISCONNECTED >
DISCONNECTED
DISCONNECTED >
DISCONNECTED

DISCONNECTED »

I Register UUID name I

Bluetooth Settings

Cancel

[

Register UUID name

Na... led switch

UUID 58837f57-5f05-4267-ab01-h4968e8ef...

Figure 4.5 Device List Screen (5)

Bluetooth Setting screen of OS can be displayed by selecting "Bluetooth Settings".

No SIM &

Filte NO FILTER

5! {no name)

T =
-7

L —4

T 8

L —3 -

- 62

&

(no name)

(no name)

{no name)

RBLE-DEV

Sort

O

0

NO SORT

No SIM 5

Filte NO FILTER

-93

-85

-73

-75

(no name)

RBLE-DEV

(no name

(no name,

(no name)

Sort

Setting

O & :

NO SORT
DISCONNECTED >
DISCONNECTED
DISCONNECTED >
DISCONNECTED

DISCONNECTED »

Register UUID name

I Bluetooth Settings I

Cancel

No SIM &

£ Settings

TRYBT

TryBT

ALLOW TRYBT TO ACCESS
a Bluetooth

Siri & Search

Figure 4.6 Device List Screen (6)

canceL
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4.2 Connected Device Detail Screen
Connected Device Detail Screen shows the connection status of Target Board for RX23W.

"CONNECTED" indicates the board is connected. Tapping this will terminate this connection. Similarly,
"DISCONNECTED" indicates the board is disconnected. Tapping this will establish a connection again.

No SIM 7 [ No SIM T (-

< Back O @ £ : <o O ® & :

RBLE-DEV RBLE-DEV

< )¢

CONNECTED

Select demo Select demo
v b v [ub
LED Lights Up Ramdom Number LED Lights Up Ramdom Number

Figure 4.7 Connected Device Detail Screen (1)

Tapping the LED Lights up button will display the Light Demo Screen. To go back to the Connected Device
Detail Screen, tap back button on the top left.

No SIM 7 [ NoSIM T (-
G O @ B s
RBLE-DEV O
'Q' —
¥ -32 -

[msec/c]
° Bl
Select demo
@ | |l @
LED Lights Up Ramdom Number
Figure 4.8 Connected Device Detail Screen (2)
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Tapping the Random number button will display the data demo screen. To go back to the Connected Device
Detail Screen, tap Back button on the top left.

No SIM 7 . NoSIMF

< Back O@@E

RBLE-DEV

Q@ 7270
C
T

32°C

CONNECTED

il
Select demo

50

40 -
@ I 30 = 30
I il J .
LED Lights Up Ramdom Number o ke . :
| |

W value

Figure 4.9 Connection Details Screen (3)

Tapping the Reload button will reload the information of Target Board for RX23W connected.

No SIM =

i [O]® @ @

RBLE-DEV

"' -32

Select demo

@ |l

LED Lights Up Ramdom Number

Figure 4.10 Connection Details Screen (4)

RO1AN6102EJO100 Rev.1.00 Page 35 of 54
15. Oct, 2021 RENESAS



Bluetooth Low Energy Smartphone Application Example TryBT for iOS

Tapping the Info button will display detailed information of evaluation board.

No SIM = [ NoSIMF -
{ Back O @ {:% E ¢ Back
RBLE-DEV RBLE-DEV

58831926-5F05-4267-AB01-B4968EBEFCEQ
led switch
Properties:Notify

5883C32F-5F05-4267-AB01-B4968ESEFCEQ
Properties:

CONNECTED

Select demo

@ |l

LED Lights Up Ramdom Number

Figure 4.11 Connection Details Screen (5)

Tapping setting button will display "Bluetooth Settings".
Bluetooth Setting screen of iOS can be displayed by selecting "Bluetooth Settings".

No SIM 7 ' NoSIM F - nNoSM T —
£ Back O @ {:6} E < Back O @ {é} E £ Settings TryBT
RBLE-DEV RBLE-DEV ALLOW TRYBT TO ACCESS
a Bluetooth ()
Siri & Search
l'l -32 ". -32
Select demo Select demo
Setting
@ I I I I I Bluetooth Settings I
LED Lights Up Ramdom Number
Cancel
Figure 4.12 Connection Details Screen (6)
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4.3 Light Demo Screen
Light Demo screen can operate the LED blinking of Target Board for RX23W LED.

———
00000 2
00000 i3
e

LR ot 2

G Sesaiam o0 e
00000000000000 i27.
00000000000000 |3
00000000] [0C00000):

TN T R VI AR R AT AT AR AT

BI -

Figre 4.13 User LED on Target Board for RX23W

Specify the blinking interval in milliseconds by using text edit or the slider. (100ms to 10000ms)

No SIM = -

.
¢ Back 0

1000

[msec/c]

@ .I
o)

Figure 4.14 Light Demo Screen (1)
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Switch on and off by tapping the power button.

¢ Back

v

1000

[msec/c]

L
® ,.I.

Figure 4.15 Light Demo Screen (2)

TryBT has Customization Mode that can change icon and graph color dynamically. When you tap the pen
mark near lamp icon, TryBT changes into Customization Mode and the lamp icon can be changed.

ones - — -
B
< Back : < Back

O Selecticon
[ ___] g
-

1000

)

1
—

-—
1

2

(=]

o

o

[msecjfc]

[msecjfc]

[ [
® ,.I. ® ,.I.

© ©

Figure 4.16 Light Demo Screen (3)
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4.4 Data Demo Screen

Data Demo screen generates a randomized number and displays temperature, humidity, and graph each
time the switch on the Target Board for RX23W is pressed. The graph stores up to ten data points.

19 9 D8 D7 Dé DS D4D3ID2e DisDE

[©60660600]

Ci SRR 5 |
000000000 22,
O00000Q00

g .

n32

R33

LED 1 [ER] 5
>

00000000000 27

, teo[
----- 00000000000000 5’

Figue 4.17

No SIM = (-

£ Back .

@ 72°c

32°C

50

40
30
20
* .

W value

Figure 4.18 Data Demo Screen (1)

5 5 0 O o e%e

cuo@_ . MADEINJAPAN O =«
S

i Ri3 H
P& @

User Switch on Target Board for RX23W
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Graph format can be switched among bar graph, line graph, and pie chart.
[ NoSIMF () No SIM T
< Back

No SIM 7
< Back E ¢ Back

oz°c ¥ 93c @ 9s°c

3°C 3°C

E

1Ll] |Pacd €N & I
w0 a7
a0
20 - 1
v
60
3
40
.0 o
20 L
a0 aa
\ ~
N -
W value

Figure 4.19 Data Demo Screen (2)

=

: IWI = 4g)
@
(@)

When you tap the pen mark near thermometer and hygrometer icons, TryBT changes into Customization
Mode and thermometer and hygrometer icons can be changed.

£ T -

< Back E < Back E
Select icon

@ o3°c m @ §:.

O
(o]
W

o
O

3°C

S
vy

fo<D

Figure 4.20 Data Demo Screen (3)

RO1AN6102EJ0100 Rev.1.00 Page 40 of 54

15. Oct, 2021 RENESAS



Bluetooth Low Energy Smartphone Application Example

TryBT for iOS

When you tap the pen mark near the graph, TryBT changes into Customization Mode and color of the graph

can be changed.

No SIM 7
< Back

S
e

©

W

o]

O

i l < Back
X

Vd

No SIM 7

Colors

Sliders

Spectrum

Grid

S
e

OPACITY

+

Figure 4.21 Data Demo Screen (4)
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5. Customizing TryBT

This chapter describes how to change application title and application icon, splash screen, and Icon data as
well as how to enable/disable customization mode of TryBT. When you customize software implementation
of TryBT, also refer to description regarding TryBT project described in the following chapters.

5.1 Customizing Application Title
The app title can be changed.

1. Open the TryBT project in Xcode. Change the app title in [Info]>[Bundle Name].

[ ] ]
EHE Z Q
~ [ TryBT
~ @ TryBT
AppDelegate.swift
B SceneDelegate. swift
B ViewController.swift
B Main.storyboard
H Assets.xcassets
B LaunchScreen.storyboard
B Info.plist
B splashviewController.swift
B BluetoothDetailViewController.swift
B Bluetoothinfo.swift
B TryBTUtiLswift
B ConnectStatusview.swift
B LightsUpDemoViewController.swift
B RandomMumberViewController.swift
B ImageSelectviewController.swift
B VersioninfoViewController.swift
B BluetoothDevicelnfoViewController...
B Configuration.swift
RegisterUUIDViewController.swift
> [l TryBTTests
> @ TryBTUITests
> M Products

> @ Pods
+ &= Filter

= TryBT)  iPhone TryBT | Build TryBT: Succeeded | Today at 11:50
=2 B TryBT.xcodeproj

® TryeT

(] General  Signing & Capabilities
PROJECT v Custom iOS Target Properties
B TryBT

TARGETS

Key
Bundle name
= TryBT

Ml TryBTTests

Bl TryBTUITests

ryboard fila base name
Config
OW_ICON_WRITE

lopment region
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Figure 5.1 Customizing Application Title

5.2 Customizing Application Icons
The app icons can be changed.

1. Open the TryBT project in Xcode. Change the app icons in [Assets.xcassets]>[Applcon].

NOTE: Change the icons for all resolutions.
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Figure 5.2 Customizing Application Icons
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5.3 Customizing Splash Screen
The splash screen, shown when the app is launched, can be changed.

1. Open the TryBT project in Xcode. Change the "splash_background" and the "splash_logo" in

[Assests.xcassets].

TryBT | Build TryBT: Succeeded | Today at 17:21

[ ] (N ] = TryBT)  iPhone
I
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~ B TryBT H iconos
B AppDelegate.swift H icono7
B SceneDelegate.swift B iconos

B ViewController.swift [ iconog
Il light_button_off

splash_background

B Main ctarvhnard
Assets.xcassets 2x
B LaunchScreen.storyboard ~ Universal
B Info.plist ;
B SplashViewController.swift
BluetoothDetailViewController....

Bluetoothinfo.swift
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B AppDelegate.swift H icono?
B SceneDelegate.swift icon08
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Figure 5.4 Customizing the Splash Screen (splash_logo)

5.4 Customizing Icon Data on the Demo Screen

Customizable icon on the Light Demo screen and Data Demo screen can be changed.

NOTE: Up to nine icons.

NOTE: Prepare png format icons with a resolution of 200x200.
1. Open the TryBT project in Xcode. Change icon01 to icon09 in [Assests.xcassets].

= TryBT}  iPhone TryBT | Build TryBT: Succeeded | Today at 17:21
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BluetoothDetailViewController....

B Bluetoothinfo.swift

Figure 5.5 Customizing Demo Screen Icon Data
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5.5 Enabling/Disabling Customization Mode

This application has a customization mode that allows you to change icons and other features while the
application is running.

1. Open the TryBT project in Xcode. Change [AppConfig]2>[IS_SHOW _ICON_WRITE] to either 0O or 1 in
Info.plist.

1: Enable Customize mode
0: Disable Customize mode
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Figure 5.6 Enabling/Disabling Customization Mode
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6. File Composition of TryBT

Folder and File Composition of TryBT is shown below. Info.plist, and swift files are described in this chapter.

TryBT:
| Podfile
|
—Pods/
—TryBT
| | AppDelegate.swift
| | BluetoothDetailViewController.swift
| | BluetoothDevicelnfoViewController.swift
| | BluetoothInfo.swift
| | Configuration.swift
| | ConnectStatusView.swift
| | ImageSelectViewController.swift
| | Info.plist
| | LightsUpDemoViewController.swift
| | RandomNumberViewController.swift
| RegisterUUIDViewController.swift
| SceneDelegate.swift
| SplashViewController.swift
| TryBTUtil.swift
|  VersionIinfoViewController.swift
|
|

ViewController.swift

|
|
|
|
|
|
|
| F—Assets.xcassets

|  L—Base.lproj

| LaunchScreen.storyboard
| Main.storyboard

|

—TryBT.xcodeproj
F—TryBT.xcworkspace
F—TryBTTests

L—TryBTUITests

Figure 6.1 Folder and File Composition of TryBT
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6.1 Info.plist

Info.plist is a file for setting the TryBT application. The Info.plist file sets the icon, version, and app display
name when the app is installed. The main setting values are shown. Please see the official website for
details. (https://developer.apple.com/documentation/bundleresources/information_property_list)

Table 6-1 Info.plist

Attribute Name Overview
Bundle version string (short) Specifies the version (string) of the application.
e.g.:1.0.0

Shows the build as a serial number.
Specifies the display name of the application.
e.g. : TryBT

Bundle version
Bundle name

6.2 .swift

Each file with a swift extension is a file that constitutes the screen and logic of TryBT. This section provides
an overview of each file.

Table 6-2 .swift

Overview

This class manages the lifecycle of the entire application,
including the definition of constants in TryBT.
BluetoothDetailViewController Defines the Bluetooth detail screen.
BluetoothDevicelnfoViewController | Defines the screen displaying information about the connected
device.

This is a structure that holds the connection information for one
Bluetooth device.

This is a utility class for retrieving data from Info.plist.

A custom view class that toggles the display between
CONNECTED and DISCONNECTED.

Class Name
AppDelegate

Bluetoothinfo

Configuration
ConnectStatusView

ImageSelectViewController

Defines the screen for icon selection.

LightsUpDemoViewController

Defines the screen where the LED demo is performed.

RandomNumberViewController

Defines the screen for the graph demo.

RegisterUUIDViewController

Defines the UUID registration screen.

SplashViewController

This is the splash screen.

TryBTUtil

This class defines utility methods.

VersionInfoViewController

Defines the screen for displaying version information.

ViewController

Defines the Bluetooth list screen for initial display.
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7. Screen Transition of TryBT

The screen class transition diagram for the TryBT screen is shown below.

pkg
e - F—

Register UUID name

. ViewController _I—) RegisterUUIDView Controller

¥ Register UUID

Device is selected
Device List Screen
UUID Registration Dialog
O @ & : s -

¢

RBLE-DEV

RI

e 3 BluetoothDetailViewController BluetoothDevicelnfoViewController
". -32 I
N — Display Device Info

7 il

Connected Device Detail Screen Device Information Screen
Light Demo is Selected Data Demo is Selected
< : 4 i g
LightsUpDemoViewController RandomNumberViewController

A\ v e

[ w 32°C

N il
Light Demo Screen Data Demo Screen

Figure 7.1  Screen and Class Transition of TryBT
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8. Bluetooth Communication of TryBT

This chapter explains how to use Bluetooth with TryBT. Please also see the official website
(https://developer.apple.com/documentation/corebluetooth) for Bluetooth on iOS.

8.1 Performing a scan with Central Manager
TryBT scan peripheral device using CBCentralManager Class.

viewDidLoad() {

.viewDidLoad()

centralManager = CBCentralManager(delegate: , queue: , options:

Figure 8.1 Initializing CBCentralManager class (ViewController.swift line 167)

startScan(){
print("begin to scan ...")

allBluetooth = Array<BluetoothInfo>()

centralManager.delegate =

centralManager.scanForPeripherals(withServices:

Figure 8.2 Scanning (ViewController.swift, line 208)

This saves the search results and displays them in a list.
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centralManager(_ central: CBCentralManager,
didDiscover peripheral: CBPeripheral,
advertisementData: [String: Any],

rssi RSSI: NSNumber) {

print("pheripheral.name: String(describing: peripheral.name))")
print("advertisementData:¥(advertisementData)")
print("RSSI: RSSI)")

print("peripheral.identifier.uuidString: peripheral.identifier.uuidString)¥n")

bluetoothInfo =

BluetoothInfo(peripheral: peripheral, advertisementData: advertisementData, rssi: RSSI)

isAddBluetooth =
for addedBluethoothInfo in allBluetooth{
if(peripheral.identifier.uuidString == addedBluethoothInfo.peripheral.identifier.uuidString){
isAddBluetooth =

break

}
if(isAddBluetooth){
allBluetooth.append(bluetoothInfo)
.refreshTablle()

Figure 8.3 Stored scan result (ViewController.swift, line313)

8.2 Connecting to peripheral device

Connects to the peripheral device. Pass the CBPeripheral class as the first argument of
centralManager.connect method.

connect(){
.centralManager.delegate =
if( .peripheral != ){
.centralManager.cancelPeripheralConnection( .peripherall)

.peripheral =

.centralManager.connect(bluetoothInfo!.peripheral, options:

statusLabel.status = ConnectStatusView.ConnectStatus.disconnected

.lightsUpDemoButton.isEnabled

.randomNumberButton.isEnabled

Figure 8.4 Connect to Peripheral (BluetoothDetailViewController.swift, line 168)
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The connection completion event is notified to the centralManager didConnect Delegate. TryBT keeps
connected Peripheral devices.

centralManager(_ central: CBCentralManager, didConnect peripheral: CBPeripheral) {
print("didConnect")

statusLabel.status = ConnectStatusView.ConnectStatus.connecting

UserDefaults.standard.set(peripheral.identifier.uuidString,

forKey: fromAppDelegate.LAST_CONNECTED_UUID)

peripheral.delegate =

.peripheral = peripheral

.lightsUpDemoButton.isEnabled

.randomNumberButton.isEnabled

Figure 8.5 Connection Event (BluetoothDetailViewController.swift, line 229)

8.3 Service Discovery

In TryBT, when the "LED Lights Up" button or " Random Number" button on the connected device details
screen is tapped, TryBT execute service discovery by specifying the UUID of the service.

lightsUpDemoPressed(_ sender: Any) {

if(peripheral != )
selectedDemo = .lightsUpDem

UUID = CBUUID(string: fromAppDelegate.demo_uuid)

peripheral!.discoverServices([UUID])

}else{

.alertDisconectMessage()

Figure 8.6 Service Discovery Lights Up Demo (BluetoothDetailViewController.swift, line 41)

When the service discovery is successful, discover characteristic.
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peripheral(_ peripheral: CBPeripheral, didDiscoverServices error: Error?) {

if (error != ) {
print("error: String(describing: error))")

return

for service in peripheral.services!

{

switch selectedDemo{
case .lightsUpDem:

serviceUUIDArray =
NSArray(object: CBUUID(string: fromAppDelegate.LIGHT_UP_SERVICE_UUID))

peripheral.discoverCharacteristics(serviceUUIDArray as? [CBUUID], for:service as CBService)

case .randomNumber:

serviceUUIDArray =
NSArray(object: CBUUID(string: fromAppDelegate.RANDOM_NUMBER_SERVICE_UUID))

peripheral.discoverCharacteristics(serviceUUIDArray as? [CBUUID], for:service as CBService)

Figure 8.7 Discovery characteristic (BluetoothDetailViewController.swift line 261)

If the characteristic can be searched, the screen will change to each screen.
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peripheral(_ peripheral: CBPeripheral,

didDiscoverCharacteristicsFor service: CBService, error: Error?) {

if (error != ) {
print("error: String(describing: error))")

return

}

if(service.characteristics!.isEmpty){

}else{

.characteristics = service.characteristics![0]

.characteristics?.uuid

switch selectedDemo{
case .lightsUpDem:

performSegue(withIdentifier: "tolLightsUpDemo",sender:
case .randomNumber:

performSegue(withIdentifier: "toRamdomNumber",sender:

Figure 8.8 Notification characteristic discovery result (BluetoothDetailViewCOntroller.swift, line 283)

8.4 Entering Values on the Light Demo Screen

On the light demo screen, the value is written to peripheral when the slider and TextEdit are changed. Pass
the data, characteristic, and writing option as arguments.

writeValue(value:Int){
value:UInt = UInt(value)

data: NSData = NSData(bytes: &value, length: 1)

peripheral!.writeValue(data as Data,

for: .characteristics!,

type: .withResponse)

Figure 8.9 Write Characteristic (LightsUpDemoViewController.swift, line 142)

8.5 Standby for Notifications on the Data Demo Screen

Sets the notification standby for receiving Rx23W button click events. Enables / disables natifications for
Peripheral devices.
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viewDidLoad() {
.viewDidLoad()
menuBarButtonItem = UIBarButtonItem(

image: UIImage(named: "btn_menu")?.withRenderingMode(.alwaysOriginal),

style: .plain N
target: .

action: #selector(menuButtonPressed))
navigationItem.rightBarButtonItems = [menuBarButtonItem]

peripheral?.delegate =

peripheral?.setNotifyValue( : .characteristics!)

Figure 8.10 Enable Notify (RandomNumberViewController.swift, line51)

Notify from the evaluation board will be notified to the following didUpdateValueFor Delegate.

peripheral(_ peripheral: CBPeripheral,

didUpdateValueFor characteristic: CBCharacteristic, error: Error?) {

if (error != ) {
print("Write...error: String(describing: error))")

return

newValuel = Int.random(in: ©...100)

newValue2 = Int.random(in: ©...100)

newGraphValue = Int.random(in: 0...100)
sampleData.append(Double(newGraphValue))
if(sampleData.count > 20){

sampleData.remove(at: 9)
}
UserDefaults.standard.set(newValuel, forKey: fromAppDelegate.RANDOM_VALUE_1)
UserDefaults.standard.set(newValue2, forKey: fromAppDelegate.RANDOM_VALUE_2)

UserDefaults.standard.set(sampleData, forKey: fromAppDelegate.RANDOM_GRAPH_VALUE)

refreshRandomValue ()

Figure 8.11 Notify Event (RandomNumberViewController.swift, line 319)
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General Precautions in the Handling of Microprocessing Units and Microcontroller
Unit Products
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/O pull-up power supply while the device is powered off. The current increase that results from input of such a signal or 1/0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guidelines for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions due to the false recognition of the pin state as an input signal become

possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between V. (Max.) and Viu (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-
evaluation test for the given product.



Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’'s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.
Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products
outside of such specified ranges.

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. Itis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Notel) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Corporate Headquarters Contact information

TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:
Www.renesas.com www.renesas.com/contact/.

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

© 2021 Renesas Electronics Corporation. All rights reserved.
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